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1.0 FUEL CELL MONITORING SYSTEM (version 2.00, 9/2002) 

1.1 FCMS Display and Operation 
Once data is being received, FCMS will be opened and the user will see all three substacks for fuel cell 1, as seen 
below. Each cell is individually numbered. Cells 1 through 16 are added together and compared to cells 17-32 to 
compute a substack delta-V. This number should be ballpark close to the value seen on the orbiter CRT but will 
probably not exactly match due to different software algorithms.  
 

 
 
In the lower right corner is a note about the the data being recorded. For the SYS PGSC class, it reads "FCMS is 
running in demonstration mode". If it's not set to run in Demo mode, it will not be present, meaning it's recording 
real data.  
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If FCMS is started and data is not available, all the data will be "XXX" in cyan (the color that signifies missing 
data).  
 

 
 
If data becomes unavailable while running, the data on the screen turns cyan and displays the last known value. 
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The program is designed to be used via the keyboard only or using the mouse. All of the radio buttons and check 
boxes on the right side are duplicated via a pull-down menu selection. 
 

       
 
Initialization parameters are read from the fcms.ini file. Initialization settings include display, color and sound 

settings, data recording and storage, telemetry, error limits, debugging/logging, and the setting for the 
demonstration mode. A log file can be generated by the FCMS application containing information on activation 
time, configuration information, user actions, and shut down time. Typically, however, this is not used unless 
troubleshooting a problem. If the fcms.ini file is changed, it can be reloaded via the File | Reinitialize menu. 

 
The FC1, FC2, and FC3 radio buttons on the right will change the display to show fuel cell 1, 2, or 3. If data is 
being recorded, this will not affect the recording since it only changes the display to the screen. The picture above 
shows Fuel Cell 1 data being displayed. Similarly, the Freeze and Record buttons only affect the data that is being 
displayed on the screen, they have nothing to do with any data that is being recorded. The Mute Sound option 
allows the user to suppress the synthesized voice audio. When the Freeze or Mute option is selected, the screen 
clearly labels what has been done. 
 

 
 
Data that is out of limits will be flagged by the program by color change. Anything out of limits (less than 920, 
greater than 1200) will turn yellow, while anything off-scale high or low will be red. This legend can be called up by 
the Help | Legend pulldown menu, and the limits and colors can be set in the fcms.ini file. 
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Note that the crew is never instructed by the procedures to look at all three fuel cells as displayed on the screen, 
and they frequently do not look at fuel cells 2 or 3, so fuel cells other than FC1 with bad telemetry may not be seen 
until the data is downlinked and processed. 

1.2 Recording data 
Pressing the "Record" button (or selecting the File | Record menu) calls up the "Recording Type" window. FCMS 
has two recording modes: Full rate or Interval. Full Rate records a sample every 0.96 seconds and records until 
the maximum file size is achieved. In Interval mode, FCMS records samples at specified intervals for a certain 
amount of time, as called out by MCC and as selected by the crew. A flag in the fcms.ini initialization file limits 

the maximum file size to 1.44 MB. Originally, the file was transferred via the wired or wireless network to a second 
PGSC for downlink, but in case there was a problem with the network, the file needed to be able to fit onto a single 
floppy disk for transfer to the second PGSC. This functionality is not used any more (the file remains on the 
WinDecom PGSC and is retrieved by MCC from there) but the file size limitation was never changed, as that file 
size is still adequate for EGIL’s purposes. 
 

 
 
When recording starts, the yellow "NOT RECORDING" label on the main display changes to "RECORDING". The 
display will also show how big the recorded file is compared to the maximum file size (default is 1.44 MB), 
expressed as a percent complete (below left). The display that tells the user that the program is recording all three 
fuel cells, to avoid confusion as to what is being recorded. (One early crew thought they were only recording the 
data for the fuel cell that was on the screen, so they ran FCMS three times). If the Interval option is selected, the 
display shows a count-down timer and a completion bar (below right). 
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FCMS will automatically stop recording when the maximum file size is reached - at the full data rate recording 
option, this will be about 12 minutes - or the timer runs out. When recording has stopped (either automatically or 
manually via the "Stop Record" button or pull-down menu), a window pops up with the file name and path of the 
data on the WinDecom PGSC. The crew then notifies MCC that the data take is complete so that MCC can 
downlink the data file. 
 
The popup window gives the file name for that data session. The raw data filename is of the form 
fcdddhhmm.fcv, where FC stands for "fuel cell"; DDD is the GMT day, HH is the hour, and MM is the minute of 

the first data point; and "FCV" is the file type "fuel cell volts." Because it is completely ASCII text, there is a lot of 
"dead space" in the file that can be compressed within the file, on the order of 90-95%. The FCMS program 
automatically creates a compressed file (a "zip" file) along with the text file, the only difference being the file 
extension (.zip instead of .fcv).  
 
When the recording is complete, the "RECORDING" label changes to "COMPLETED" and the raw data file name 
shows up below that. 
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2.0 CABIN LEAK (version 4.03, 7/2007) 

2.1 Overview 

  
 

The Cabin Leak application is used primarily to compute the time remaining before the orbiter should perform a 
deorbit burn to safely reach an Earth landing site. The latest deorbit burn time, or latest Time to Ignition (TIG), is 
the MET in which enough O2 and N2 exist to sustain survivable orbiter cabin environment until landing.  
 
Cabin Leak is an electronic version of the cabin leak nomographs found in the Orbit Pocket Checklist. The 
application, reconfigurable for all on-orbit operations, provides the times of 8 psi Stabilization, N2 Depletion, and 
Latest TIG in both elapsed time from when at which the solution was computed to the event (i.e., Latest TIG, N2 
Depletion, etc.) and MET. Cabin Leak is preferred over the nomographs as it provides more precise information 
without having to interpolate as on the nomographs and is in fact called out in the Flight Data File as the preferred 
method.  
 
Cabin Leak has both an automatic mode and a manual mode.  
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 The default mode is Automatic: PCMMU data is received via the Telemetry Server and calculation occurs 
every 10 seconds or at the user-specified rate.  

 Manual Mode is entered by selecting the “Manual Entry” radio button. In Manual Mode, parameters such 
as dP/dt and cabin pressure can be entered manually and the Manual Compute button is enabled to 
calculate the times. 

The Time/Vector Server supplies current MET and GMT to Cabin Leak and the Update functions for the MET and 
State Vector. The present Cabin Volume configuration is selected from a treeview Control (a drop down list) 
specified by the flight specific INI file. Manual and Auto operations will be discussed in following sections. 
 
The Cabin Leak program is located in the <c:\spocapps\cabinleak> directory or can be accessed from the 

Shuttle Apps window. 
 
Across the top of the display are three menus: File, Update, and Help. 

2.1.1 File  
The File menu has three options: Reset, Settings, and Exit.  

 Reset: Resets the Cabin Leak application. Use this if Cabin Leak doesn’t attach to the Time-Vector Server 
or Telemetry Server correctly when first started. If the MET Server or Telemetry Server has not been 
installed on this computer, Reset will be ineffective. Cabin Leak can still be used in Manual Mode without 
automatic Telemetry data. 

 Settings: Allows the user to change the default update time from every 10 seconds to another value. 

 Exit: Closes the Cabin Leak application. 

2.1.2 Update 
The Update menu has two options: State Vector & Times, and Update Parameters. In general, the Systems 
Instructor will not have to use any of these. 

 State-Vector & Times: Brings up the Update Orbiter State Vector and Update Time Values windows of the 
Time-Vector Server (MET Server). Cabin Leak is paused until the Update Orbiter State Vector window is 
closed.  

 Update Parameters: Allows the user to change the default values for number of N2 tanks (default = 6, but 
set flight-specific), maximum N2 flow in lb/hr (default = 250), and minimum acceptable ISS pressure 
(default = 9.5 psi). 

2.1.3 Help 
The Help menu has two options: Contents and About.  

 Contents calls up the “help file” for the cabin leak program. 

 About calls up information on the program version number and programmers (as seen at the top of this 
section). 

2.2 Inputs 
The cabin leak program has a number of fields that will be filled in either manually or automatically if telemetry is 
available, as well as fields that are set prelaunch as part of the initialization file (cableak.ini). 

2.2.1 Pre-initialized data 
 
According to the FDF Cabin Leak procedure, the crew is instructed to close all hatches (including airlock) to try to 
isolate the leak. If the leak is in the crew compartment, the crew opens the airlock hatch to use that volume, and 
only then are they instructed to use the cabin leak program (as seen below). When they do call up the program, 
the cabin volume is defaulted to be orbiter plus airlock (2,703 ft

3
), to match the orbiter hardware config and the 

nomograph. The crew can change that value by using the pull-down menu to select orbiter only volume (2,475 ft
3
),  

if needed.  
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The input fields for the number of N2 tanks, the maximum N2 flow, and the minimum acceptable pressure for the 
additional volume are all set in the Update | Update Parameters pull-down menu and are generally not changed 
during the execution of the program (though the values can be updated if needed). 

 Number of N2 Tanks: the flight-specific number of N2 tanks flown on the shuttle flight. Valid values are 4, 
5, 6, 7, or 8. This has an effect on the amount of N2 that is unusable due to being trapped in the tanks. 
Default is 6, but this will be set flight-specific. 

 Max N2 Flow: Input field for the maximum N2 flow (typically set to 250 lbm/hr). 

 Minimum Acceptable Additional Volume Pressure: If the orbiter has a leak while docked to ISS, the 
volume of air in the ISS segments may be used to extend the time to latest TIG. The nominal value to 
leave the ISS components is 9.5 psi.  

 

 
 

2.2.2 Telemetry input data 

 
 

 
 
The telemetry data displayed on the screen can be found by the crew on various CRT MDU displays. The status 
box at the bottom displays whether telemetry is available or not; if for some reason telemetry is not available to the 
PGSC (for example, some sort of PCMMU failure) then the user may select the Manual Entry radio button in the 
Data Source section. When PCMMU Feed is selected, the telemetry data elsewhere on the display is grayed out 
and the user may not change anything, but when Manual Entry is selected the fields turn white and may be 
manually entered.  
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 Apogee Height: This information is displayed on the crew’s GNC MNVR OPS 2 MM202 and OPS 3 
MM301, 302, and 303 displays. Although there is a 400 nm default limit, a higher value can be set within 
the INI file. This field is used in calculating the time from TIG to Touchdown, and will typically be in the 
neighborhood of 1:05 hr for ISS altitudes. For the paper nomographs in the checklist, this value is 
assumed to be one hour. 

 MET for Computation: The standard format is ddd/hh:mm:ss. The number of hours cannot exceed 23, 
minutes cannot exceed 59 and seconds cannot exceed 59.  

 dP/dt: If dP/dt is positive or less than -0.0001 psi/min a cabin leak is not occurring.  

 Cabin Pressure: A valid Cabin Pressure cannot exceed 20 psia.  

 N2 Quantity 1 & 2: The maximum value should not exceed 800 for the combined quantities of both N2 
tanks.  

 dP/dT-EQ: If this is positive or less than -0.0001 psi/min a cabin leak is not occurring. This is just the dP/dt 
normalized to a 14.7 psi cabin pressure. 

 Orbiter + ISS Volume: not telemetry, and will be covered in the next section. 

 dP/dt-EQ (ISS): This value is the dP/dt-EQ from the shuttle, scaled to show what it would be 
(hypothetically) if the hatches to the ISS were open, and is inversely proportional to the total volume (e.g., 
if the stack volume is 10x greater than the orbiter volume, then the dP/dt will be 10x smaller when the 
hatches are all open). Recall that when this Cabin Leak program is executed, the hatch from the shuttle to 
ISS is closed. This value will be used later in determining whether or not the ISS volume may be used to 
extend the orbiter’s time on orbit. This function will be covered later. 

 ISS Pressure: this is the pressure in the US Lab module on ISS. 
 
If the PCMMU Feed radio button is selected, meaning the user wants telemetry to populate the fields on the 
display, but that the telemetry is not available, the white fields are filled in cyan with an “M” to indicate missing 
data. Manual Entry must be used in this case. The Height of Apogee reverts to a default value of 165 nm and MET 
reverts to liftoff. 
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2.2.3 ISS Volume/Hatch Configuration 
In the case where the orbiter will remained docked to the ISS in order to use their atmosphere, the user must 
manually set the ISS volume, as there is no telemetry to be read regarding the status of the various hatches inside 
the ISS. Any closed hatch seals off the volume behind it (relative to the orbiter), rendering it unusable for the 
shuttle. The FDF sends the crew to work the “Utilize ISS Atmosphere” steps in the procedure below, but those 
steps assume that the entire ISS volume is available. The right side of the Cabin Leak display covers the case 
where the orbiter is remaining docked to conserve air. 
 

 
On the ISS side of the Cabin Leak display, the user is shown a field with the ISS volume. That value cannot be 
entered manually, but by using the Hatch Configuration tool, the proper volume can be set. The crew must select 
the hatches in this window to be closed as appropriate to match the current config.  
 

 
 
This window has a “tree view” control of the various hatches from the orbiter middeck all the way to the back of the 
ISS. The “Cabin Volume” label at the top of this window will be calculated for that configuration. The check box 
logic matches the ISS and orbiter configuration so that when an inner hatch is closed, the hatches further out don’t 
matter and are grayed out - for example, when the orbiter inner hatch is closed, it no longer matters to the 
calculation whether the hatch into the FGB is open or closed. All hatches are always initialized as open when 
called up for the first time, and the program will remember the hatch status when the window is closed.  
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Note that it is VITALLY IMPORTANT to have the correct volume setting when running the program. An incorrect 
setting will give the crew an incorrect TIG.  

 If the volume setting in the program is bigger than the actual volume at the time the program is run, the 
program will display a time that is less than the crew actually has. This could result in the crew rushing or 
taking a deorbit opportunity that is not as good as another. 

 If the volume setting is smaller than the actual volume at the time the program is run, the program will 
display a time that is more than the crew actually has. This could result in the crew running out of air. 

 

2.2.4 Equivalent dP/dt 
With Manual Entry selected, the program automatically calculates the value of Eq dP/dt, given dP/dt, using the 
formula for calculating Equivalent dP/dt: 
 

Pcabindt

dP
EQ

dt

dP

_

7.14
  

 
Inputting dP/dt will set the value of the Equivalent, so if the cabin pressure is less than 14.7 psi (unlike all of the 
previous examples), then the two dP/dt values will be different: 
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2.2.5 Settings in the cableak.ini initialization file 

Following are some of the parameters in the cableak.ini file that control how the program operates. Only the 

parameters that are relevant to training will be discussed. Any line that is preceded by a semicolon is commented 
out and the program ignores what comes after the semicolon. The file is located at  
<c:\spocapps\cabinleak\cableak.ini> 

 
[FLIGHT_DATA] 

Flight=STS-XXX 

 This controls what is seen on the top of the display 
 
[DefaultValues] 

;Defaults should be used for flight initialization. 

MaxN2Flow=250 

;Default DpDt=0 (leak rate) 

DpDt=0 

;Default DpDtEQ =0( Eq leak rate) 

DpDtEQ=0 

;Default ISSDpDtEQ =0( Eq leak rate) 

ISSDpDtEQ=0 

;Default Cabin Pressure=14.7 

CabPress=14.7 

;Default ISS Pressure=14.7 

ISSPress=14.7 

;Default N2 Quantity 1=128 

N2Q1=128 

;Default N2 Quantity 2=128 

N2Q2=128 

;Default Apogee Height=165 

HA=165 

 In general, these default values should not be changed in this file. The dP/dt values, N2 quantities, cabin 
pressure, and apogee height will be read in from telemetry if PCMMU data is available, but can be set 
from the main window if needed. The default values will appear if there is no telemetry. 

 
[FLT_SPEC_CONSTANT] 

N2Tanks=6 

;If the orbiter will not be docked to the ISS, use a value   

;Minimum Acceptable Additional Volume Pressure = 8,  

;however If the orbiter will dock to the ISS,  

;use Minimum Acceptable Additional Volume Pressure =9.5 

PSI=9.5 

 These flight-specific parameters will be determined by EECOM prior to the flight and will be in the flight 
PGSC load. The minimum cabin pressure for the ISS is 9.5 psi for the Russian segment.  

 
[ORBITER_CONFIG] 
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;Inner_Hatch,228 

;Single_SH,1211 

;Double_SH,2422 

ORB Only=2475 

ORB+EXT ARLK=2703 

 [HATCH_CONFIG] 

;These HATCH_CONFIG parameters are used only when Use_ISS_Volume=True 

CABIN_ONLY_VOLUME=2475 

NUM_HATCHES=22 

 The CABIN_ONLY_VOLUME is the default value for the cabin volume, used until something else is chosen 

from the volume calculator 

 The number of hatches in this parameter should match the number of “THATCH” parameters below.  

 
; key it links to (its parent node), name of the hatch, key (usually the name), and  

; Volume of that area 

 

; Orbiter volume including cabin_only_volume 

THATCH_1=,Inner Hatch,228 

;Iss volume 

THATCH_2=Inner Hatch,ODS Upper Hatch,1,40 

 The sequence of fields for the hatches is: 
o hatch number 
o Name of the hatch immediately upstream (towards the orbiter) of this hatch, aka “parent hatch”. If 

there’s nothing between the equals sign and the first comma, like Hatch 1, then it’s at the top of 
the tree and closest to the orbiter and has no “parent”. 

o This hatch’s display name (what it shows on the volume calculator window) 
o A flag (1, 2, or 3) – see below 
o volume size 

 
THATCH_3=ODS Upper Hatch,APAS Hatch,1,183  

THATCH_4=APAS Hatch,Node 2 Fwd Hatch,1,2237  

THATCH_5=Node 2 Fwd Hatch,Node 2 Stbd Hatch,1,2308 

THATCH_6=Node 2 Stbd Hatch,Node 2 Deck Hatch,2,1637 

THATCH_7=Node 2 Deck Hatch,Node 2 Port Hatch,2,4443 

THATCH_8=Node 2 Port Hatch,JPM Ovhd Hatch,1,1437 

THATCH_9=Node 2 Ovhd Hatch,Lab Fwd Hatch,3,3497 

THATCH_10=Lab Fwd Hatch,Node 1 Fwd Hatch,1,1948 

THATCH_11=Node 1 Fwd Hatch,Node 1 Stbd Hatch,1,908 

THATCH_12=Node 1 Stbd Hatch,IV Hatch,1,201 

THATCH_13=IV Hatch,Node 1 Aft Hatch,3,203 

THATCH_14=Node 1 Aft Hatch,FGB GA-PMA1 Hatch,1,230 

THATCH_15=FGB GA-PMA1 Hatch,FGB GA-SU Hatch,1,239 

THATCH_16=FGB GA-SU Hatch,Soyuz SA-BO Hatch,1,133 

THATCH_17=Soyuz SA-BO Hatch,FGB PGO-GA Hatch,3,1925 

THATCH_18=FGB PGO-GA Hatch,FGB PGO-SU Hatch,1,262 

THATCH_19=FGB PGO-SU Hatch,SM PKhO-SU Hatch,1,845 

THATCH_20=SM PKhO-SU Hatch,SM RO-PKhO Hatch ,2,2719 

THATCH_21=SM SM PKhO-SU Hatch,SM RO-PrK Hatch,1,124 

THATCH_22=SM RO-PrK Hatch,SM PrK-SU Hatch,1,221 

 The last of these hatches should have the same number as the NUM_HATCHES parameter earlier. 
 

;Each hatch opens into a certain volume as opened going from the shuttle orbiter. 

;Each volume for an open hatch is added to the cabin volume until a closed hatch  

; (checked) is found so that the resulting volume is always correct no matter which  

; hatches are closed or in what order they were closed. Hatches closer to the  

; orbiter determine the volume regardless of whether outer hatches are closed or  

; open.    

;The CABIN_ONLY_VOLUME= parameter specifies the volume when the innermost 

;hatch is closed - the smallest volume.   
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For the explanation of the flag in the hatch sequences above, it helps to refer to this hatch config schematic and to 
think of it as a “family tree”, with parents, children, branches, and generations. A “parent” hatch is the next one 
immediately above the hatch in question on this diagram, usually closer to the orbiter at the upper left. A “child” 
hatch is generally the next one immediately after the one in question, farther away from the orbiter. A ‘branch” 
represents a hatch off of the main “core”, for a volume that sticks off of the side, which may have more hatches 
downstream of it. 
 

 
 
 
A “1” means that this hatch is the “child” of the one immediately preceeding it in the list. Thus, THATCH_11=Node 

1 Fwd Hatch,Node 1 Stbd Hatch,1,908 means that Hatch #11 is the Node 1 Stbd Hatch and is 

immediately downstream of the Node 1 Fwd Hatch, and that the next volume after the Node 1 Stbd Hatch 
(towards the bottom right of the display, or towards the aft of the ISS) has a volume of 908 cu ft. 
 
THATCH_12=Node 1 Stbd Hatch,IV Hatch,1,201 means that the IV Hatch is downstream of the Node 1 

Stbd Hatch, and the volume after the IV Hatch is 201 cu ft. 
 
Now, the next hatch, THATCH_13=IV Hatch,Node 1 Aft Hatch,3,203 has a “3” flag instead of a 1. Notice 

on the picture that the next hatch vertically up from the Node 1 Aft Hatch is the IV Hatch, which is in a different 
branch. You have to go up 3 “generations” on the diagram in order to get to the previous hatch in sequence from 
the orbiter, as both the Node 1 Aft and Node 1 Stbd both are downstream (or “children”) of the Node 1 Fwd Hatch. 

2.2.6 Future volumes on ISS 
The current version of the program will be able to handle additional volumes by adding lines as appropriate to the 
HATCH CONFIG section. 
 
At this writing, only Node 3 and the Cupola remain to be installed. Node 3 will be off of the Node 1 Port Hatch, and 
the Cupola will be off of the Node 3 Deck Hatch. These will eventually go on the diagram between the Node 1 Stbd 
and Node 1 Aft hatches: 
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 Node 1 Fwd Hatch 
  Node 1 Stbd Hatch 
   IV Hatch 
  Node 1 Port Hatch 
   Node 3 Deck Hatch 
  Node 1 Aft Hatch 
   FGB GA-PMA1 Hatch 
    Etc. 
 
Thus, the flag for Node 1 Aft Hatch will eventually have to be changed to a “5” to represent the two additional 
hatches required in the program to get back to the Node 1 Fwd Hatch. 
 
Other volumes not accounted for on this diagram include the MPLM and HTV (both off of the Node 2 Deck Hatch).  
 
Additionally, the program assumes that two of the three docking ports on the Russian segment are occupied: a 
Soyuz at the FGB Nadir (FGB GA-SU Hatch), and a Progress, Soyuz, or ATV at the SM Aft (SM Ro-PrK Hatch). 
Left empty is the DC Nadir (SM PkhO-SU Hatch). 
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2.3 Outputs 

 
 

 
 
Basically, what we’re trying to do is to display two different deorbit TIGs, one that’s the most conservative that 
covers just the orbiter and airlock and gives the soonest they’d have to deorbit, and one that answers the question 
“if we opened up to the ISS and used some of that air, how much longer could we stay in orbit?” 
 
The bottom section of this display is for the calculated data that the crew will use to base their deorbit plans. It 
consists of two tables, one with times for the undocked case (“Orbiter Only”) and one with times for the docked 
case (“Utilize ISS Atmosphere”). In each, the first column is read as “time or duration of this event from now” while 
the second column is read as “this event will occur at this MET (Mission Elapsed Time, from liftoff)”. 
 
First, we’ll talk about the Orbiter Only case. 

 Time to 8 psi stabilization: this is the time it will take for the cabin pressure to fall to 8 psi. Once the 
pressure is below 8 psi, the emergency cabin regulator valves will open and flow either O2 or N2, 
depending on how the PCS valves have been configured. In the above example, it will take 1 hours 21 
minutes for the pressure to drop to 8 psi, which will occur at 001/13:33:36 MET. 

 Time at 8 psi to N2 depletion: assuming the crew has performed the rest of the cabin leak procedures in 
the Orbit Pocket Checklist, by the time the cabin pressure has dropped to 8 psi, the valves have been 
configured to flow N2 into the cabin to make up cabin pressure. The cabin P is required to be no less than 
8 psi (the lowest pressure at which the hardware in the cabin has been certified). O2 will flow as needed to 
keep the PPO2 within limits while the crew is not yet in their ACES suits. But since the O2 is also used for 
fuel cell production, there is far more O2 than N2, thus the N2 is the limiting constraint, so the crew must 
be on the ground by the time the N2 runs out so the cabin pressure will stay at or above 8 psi. This 
represents the time from when the cabin pressure first drops to 8 psi until the N2 is depleted and the 
pressure falls below 8 psi. In the above example, once the cabin pressure drops to 8 psi in 1:21 from now 
(at 001/13:33:36 MET), the N2 will last a further 6 hours 3 minutes beyond that until 001/19:36:54 MET. 

 Time from TIG to TD: is the time between the deorbit burn and touchdown. At ISS altitudes (around 200 
nm) this is about 1:05 hr. 

 Latest TIG: is the combination of three factors that have already been calculated – the time until the cabin 
pressure drops to 8 psi, the time while at 8 psi until the N2 is depleted, and the time from deorbit burn TIG 
until touchdown. These factors will determine the latest time that the crew can do the deorbit burn and not 
run out of N2 before landing. The simple equation is (time to 8 psi) + (time at 8 psi until N2 depletion ) – 
(time from TIG to touchdown) = time until latest TIG. This time of Latest TIG is read by the Deorbit 
Manager PGSC program in order to determine what landing sites are available up to this TIG. In the 
above example, adding the time to 8 psi (1:21), the time at 8 psi until N2 depletion (6:03), and subtracting 
the time from TIG to touchdown (1:03) results in a TIG no later than 6 hours 21 minutes from now, or 
001/18:33:36 MET. 

 
Things are a little different when docked to ISS. In this case, the objective is to find out how long it will take for the 
entire stack (orbiter plus ISS) volume to drop to the minimum pressure. The idea is to see how much additional 
time can be gained remaining on orbit with a shuttle cabin leak, in order to make a better landing site or to perform 
repairs. 

 Time to ISS at 9.5 psi: is the time it will take for the total stack volume to fall to the minimum acceptable 
pressure (9.5 psi is the lower limit for the Russian Segment modules). The hatches to the ISS would be 
open until the entire stack dropped to 9.5 psi, after which the hatches would be closed and the volume 
would be the orbiter only from there to landing. In the above example, it will take 9 hours 51 minutes to 
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bring the entire ISS stack down to 8 psi (9:48 to get down to 9.5 psi, and 0:03 to get from 9.5 to 8.0). The 
time to N2 depletion is the same regardless of whether it’s the orbiter only or the orbiter plus any extra 
volume, so it’s not repeated.  

 Latest TIG (Utilize ISS Atmosphere): is calculated similarly to the Latest TIG (Orbiter Only) except that it 
accounts for orbiter + ISS as well as just orbiter only. In the above example, the ISS/orbiter stack will get 
to 9.5 psi in 9:48 from now, followed by orbiter-only O2/N2 maintenance which ends 6:03 after that, for a 
latest TIG of 14:51 from now at 02/02:03:50 MET. By utilizing the ISS atmosphere, the shuttle crew has 
gained an additional 8 hrs 30 min to complete repairs or land at a more desirable landing site. 
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3.0 10-2 DEPRESS (version 2.05, 4/2001) 

3.1 Overview 
The 10-2 Depress application automatically displays the current Cabin Pressure and PPO2 Pressure on the Ten2 
Depress Chart. The Cabin and PPO2 Pressures are also displayed numerically, along with the DP/DT value, 
changing actively as the PCMMU sample rate allows. Ten2 Depress also displays the current valve configuration 
based on the current zone, the MET and GMT, Approximate Next Zone and its corresponding crossing time. 
 
The 10.2 Depress program is located in the <c:\spocapps\10-2> directory or can be accessed from the 

Shuttle Apps window. 
 
As data feeds the application, a point will be plotted on the chart representing the Cabin Pressure versus the 
PPO2 Pressure. As the Cabin and PPO2 pressures change, the application will automatically display the current 
zone information in the right-side status bar. While points are being displayed, outside the control and target 
zones, the application plots predictor points for the next five positions. If the values have not changed since the 
last time a sample was taken from PCMMU, then no prediction is made, based on a stand-still. When a zone 
boundary is crossed, an audible alert is initiated, as well as making the valve configuration flash in the right-side 
status bar.  
 

 
 
The program is designed for minimal crew intervention. When the program is opened, it immediately begins 
looking for telemetry. A red "OFF" or green "ON" in the lower right corner indicates whether it is reading demo data 
from the initialiazation file or telemetry from one of the various packets.  
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The left side of the screen duplicates the 10.2 depress chart from the EVA checklist, but by automatically plotting 
data, it frees a crewmember from having to monitor a CRT and plot the points by hand. With the PGSC program, a 
crewmember can be on the middeck (where the switches that need to be moved are) monitoring the display. The 
right side of the screen includes information on the predictor bugs, the next zone projected, cabin atmosphere info, 
and the expected current PCS valve positions. 
 

3.1.1 The "File" Menu 
The only option under the File menu (aside from Exit) is to Replay a previously recorded data file. This is 
analagous to being able to go back to the paper diagram and look at an old depress plot; data on cabin pressure 
and PPO2 are saved to a file that is uniquely identified. The operation of the Replay option will be discussed later. 
 

 

3.1.2 The "View" Menu 
Through use of the pull-down menus, the user can configure the program in various ways, modifying the reading 
of the data or how the data is presented. The first option in the View menu allows the user to show the plot either 
with or without a grid. The "without" option is the default. The use of a grid would make it easier to determine the 
values of a data point plotted previously. Three other options – Packets, PPO2 Sensor, and Pressure Sensor – are 
greyed out when the Demo mode is selected. To show these options, select the Update | Data Source | Telemetry 
menu option (to be discussed shortly). 
 

  
 
Selecting View | Packets allows the user to choose between Packet 35 (the default) and Packets 25 & 30. See 
Section 0 for an overview of packets. 
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Also under the View menu, the user may choose an alternate PPO2 or Pressure sensor. PPO2 sensor A and the 
Cabin Pressure sensor are the defaults, but if either is considered failed, the user may bypass that sensor (for 
example, PPO2 A and Cabin P are both powered by a single circuit breaker on panel O14) in order to use the 
program.  
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The user can also select the valve configuration for a particular region by way of the View menu.  
 

 
 

3.1.3 The "Update" Menu 
The Update menu allows the user to make changes to how the program operates and plots points on the display.  
 

 
 
The first three options bring up dialog boxes to make selections, while the last option lets the user decide between 
real telemetry and demo mode. The first one allows for the setting of the "delta-time", that is, the time duration 
between data points on the display. The default for a typical depress procedure would be 60 (seconds); the EVA 
Checklist calls for a new data point every 1 minute. For training purposes, this can be set to something like 5 to 
show a semi-realistic update rate. 
 

 
 
The predictor rate allows the user to select how many predictor bugs are used in determining the next zone and 
the time to the next zone. Typically 5 or 6 is good enough. 
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When the "color chart" button is selected, the color abbreviation chart appears and the text for the particular color 
becomes a dialog box. 
 

 
 

Finally, the user can select between "real" data and demo telemetry. For training purposes, the only reason to 
select "telemetry" is to let the View menu show some additional options. If telemetry is selected and no telemetry is 
available, the data box in the lower right corner turns yellow, warning of the "loss" of data. 
 

 
 

3.2 10-2 OPERATION 
The 10-2 program is essentially hands-off unless the user wants to change options. The program will display data 
as soon as it is called up, and the only manual intervention required is to change valves at the appropriate times.  
 
As the cabin pressure and PPO2 change, a series of dots are plotted on the display. A green dot means a data 
point inside the Approach Zone, while it is brown outside of it. The small red dots are predictors for the program to 
calculate the next zone and the time to the next zone. All of these parameters may be changed manually (as 
discussed above in the Update menu).  
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Since there is no telemetry associated with the airlock depress valve and both 14.7 psi cabin regulator inlet valves, 
the program displays the expected valve position for the current region in the lower right.  
 

 
 
Moving the cursor over any zone's underlined title (such as O2 REPRESS ZONE or APPROACH ZONE) turns the 
cursor from an arrow into a pointed-finger, and clicking the region's title brings up a text box with the valve config 
for that region (for example, to remind the crewmember what the valve config will be for the next zone). The text 
box can also be called up using the View | Show Valve Configs menu option. 
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4.0 WATER DUMP (version 3.0, 9/2002) & CONTROL PANEL (version 

2.00, 9/2002) 

The Water Dump program (along with the training-only Control Panel demo) is an electronic version of the Flight 
Data File "Supply/Waste Water Dump" procedure. The Water Dump program uses telemetry to determine when to 
advance from one step to another, and when telemetry is not available (such as during a standalone training 
session), the Control Panel must be used to simulate telemetry. 
 
The Water Dump and Control Panel programs are located in the <c:\spocapps\WaterDump> directory or can 

be accessed from the Shuttle Apps window. The Control Panel will only be installed for standalone training (not in 
the SMS) and is not part of the regular PGSC load that the crew uses in orbit. 

4.1 Control Panel Demo 
Because the SST and classrooms do not have simulated PCMMU data to display on the screen, the Water Dump 
program cannot tell when the supply/waste water switches have been moved, and the program will not 
automatically advance to the next step when appropriate. For standalone lessons, a demo program may be run to 
simulate the switches on panels R11L and ML31C in conjunction with the water dump program. This program is 
only available on standalone PGSCs and must be manually installed.  
 

 
 

In order to run the Water Dump program in demo mode, the Water Dump Demonstration Panel must first be 
called up. 
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The demo panel has simulated switches for the supply and waste system on panels R11L and ML31C (any switch 
not shown in the up or down position is a dummy switch for display only). The tank quantity and line/nozzle 
temperatures can all be manually entered, and the "Set" buttons must be pressed to send the data to the main 
program. Telemetry droputs can also be modeled from a button at the top of this page. By use of a radio button at 
the top right, you can have the program display either R11L, ML31C, or both. 
 
When using this program for standalone training, the tank valves should be set to either the standard configuration 
(A outlet closed, B&D tied, C isolated, crossover open) or the water transfer configuration (A&B tied with B inlet 
closed, C&D tied, crossover closed) depending on the specifics of the mission. Tank quantities should be set 
appropriately, and the dump line temp should be set to at least 65. The nozzle temps should be set fairly low. 
 
As the Water Dump program progresses through the timeline, the operator will need to change the values of the 
nozzle temps and tank quantities at various points. Remember to hit the "Set" button to send the data. 
 
The initiliazation file WtrDemo.ini contains only the status of the switches, heaters, and temperatures that are 

set via the demo panel, so there is no need to modify the WtrDemo.ini file. 
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4.2 Water Dump program 

4.2.1 Menus 
There are four pull-down menu options: File, Update, View, and Help. The File menu allows the user to select Exit, 
to quit the program. The Help menu allows the user to call up the Help file and to view the About information (as 
seen above). Update and View are discussed below. 

4.2.1.1 Update 
During operations of the Water Dump program, the user may change the dump target (by duration or quantity) by 
either pressing the “Change Amount” button in the upper right corner of the display or by the Update pull-down 
menu and selecting “Dump to Amount”. 
 

 
 
Also under the “Update” menu is “Time Data” which allows the user to modify the GMT, MET, launch time, and 
related parameters. 
 

4.2.1.2 View 
The View menu has four options: Settings, Schematic, Spec 66, and Event Log. 

 Settings allows the user to change the sound (no sound; simple sounds, typical of Windows; or voice), the 
number of digits to be shown on the display, and the scrolling capability. The program will normally show 
only the current step, the one ahead, and the one behind. The scrolling option allows the user to review 
steps that have already occurred, but does not allow future scrolling because the next steps are 
determined based on various events occurring or not. 

 

 
 

 The Schematic menu choice calls up the combined supply and waste water schematic. This diagram is 
dynamic and will change as appropriate based on the various switch throws and telemetry (simulated or 
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true). This display notes the most recent action. The Schematic automatically appears when either kind of 
dump starts, but may be called up separately if desired. 

 

 
 

 The “Spec 66” menu choice brings up a digital summary of the dump status as if the crew were looking at 
it on the Spec 66 display. This is not called up automatically like the Schematic is. 

 

 
 

4.2.2 Program setup 
Before any switches are thrown, the user must first tell the program which type(s) of dump(s) will be performed: 
supply only, waste only, or simo. Additionally, telling the program whether comm is available or not will suppress 
some messages. Finally, the user must enter either the duration or the target quantity of the dump. For the waste 
and simo dumps, a Caution to not dump the waste tank below 5% appears. 
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Waste Dump Setup 
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Simo Dump Setup 
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Supply Dump Setup 

 
 

The next window is a series of notes for the crew regarding the dump. The content is based on whether the 
"Comm available" was checked on the previous window or not. 
 
  With comm No comm 

   
 
The various windows from this point on are based on supply, waste, or simo dump. Each follows the FDF 
procedures. 
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4.2.3 Procedures 

4.2.3.1 Step A: Supply/Simo Dump Prep 
For a supply or simo dump, the crew is given a note about the Supply Water Dumpline Purge Device. The 
mechanism is inserted into the Potable quick-disconnect (QD), which lies between the dump valve and the dump 
isolation valve. It allows air to flow through the device and into the dump line and then overboard, at the point in 
the procedure when the dump isolation valve is closed and the dump valve is open. This is intended to prevent 
water accumulating at the dump valve and freezing, which has caused some water to leak overboard through the 
cracked valve. 
 

 
 
The QD is explicitly referred to not only by name but also by color. This is intended to prevent the crew from 
inadvertantly inserting the device into the wrong QD (the yellow Waste QD), which then contaminates the purge 
device (as has happened on previous flights). The Next button brings up a window to follow along with the various 
switch throws. 
 
The top of the display reminds the user that Demo Mode is running, it repeats the dump mode (Supply, Waste, or 
Simo), and it reminds the dump type (duration or percent), which can be changed at any point. 
 

4.2.3.2 Step B: Pre-Dump FDA 
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If comm is available, a reminder that MCC will TMBU the various limits shows up. If not, a Spec 60 window 
appears with the various parameters for the crew to change. Tables A and B data will be on this window 
depending on whether it is a supply, waste, or sim o dump. 
 

 
 

 
 
At this point, the program is waiting for the crew to hit Next. The black arrow points to the current step. 
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4.2.3.3 Step C: Simo Dump H2O Tk N2 Reg Config 
 

 
 
The program stops on an action: in this case, the crew should open the N2 valves. Since there is no telemetry on 
those valves, they will have to press Next to continue with the program after opening the valves. The flashing 
green hand indicates an action for the crew. 
 
At this point for a simo dump, a second window appears so that the user can do both a supply and waste dump in 
separate windows.  

4.2.3.4 Step D: Supply H2O Dump Nozzle Htr Activation 
 
The program first checks the temperature of the supply water dump line. If it is below 65, a star block in the 
procedures tells the crew to activate dual heaters. 
 

 
 
Once the temps are above 65, or when the second heater is activated, the program verifies that the dump isol 
valve is open (step D2), then waits for telemetry on the dump valve enable/nozzle heater to show on. The green 
flashing hand points to a step that is required. The program will verify the position of the dump valve in step D4. 
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4.2.3.5 Step E: Waste H2O Dump Nozzle Htr Activation 
 
The program first checks the temperature of the supply water dump line. If it is below 50, a star block in the 
procedures tells the crew to activate dual heaters. 
 

 
 
Once the temp is above 50, or when the second heater is activated, the program verifies that the dump isol valve 
is open (step E2), then waits for confirmation of the dump valve enable/nozzle heater to be on. The green flashing 
hand points to a step that is required. The program will verify the position of the dump valve in step E4. 
 

 

4.2.3.6 Step F: Supply H2O Dump Initiation 
 

 
 
The program will proceed when the nozzle temps exceed 100 degrees, so set the temps greater than 100 and hit 
the "Set" button on the control panel. This is not required if operating in the SMS with "real" telemetry. 
 
When the temps exceed 100 degrees, the background flashes green. The flashing green hand points to the next 
step, to open the supply dump valve.  
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When that's complete, the program waits for the quantity to get down to the specified level (in the upper right 
corner).  
 

 
 
A schematic of the supply and waste water system appears when the program starts. The status of the valves, 
heaters, and water dump is color coded based on telemetry. The view below shows a dump from tanks B and D, 
with the nozzle heater on and no waste dump in progress. 
 

 
 
When the current value of the tank quantities are within 2% of the desired level, the display background flashes 
dark green. 
 

 
 
Note that the current tank quantities will be close (within 1%) but may not be identical to what’s displayed on the 
crew’s displays, if they compare the PGSC output to orbiter data. The WaterDump program apparently truncates 
while the data on the display is rounded. This would have the effect of triggering the “lower limit” warning on the 
PGSC slightly sooner than would be annunciated as an SM Alert, but the difference is not significant. 
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4.2.3.7 Step G: Waste H2O Dump Initiation 
When the waste nozzle temps exceed 250 and the tank valve is verified open, the program steps to the next item, 
to open the dump valve, and shows the warning not to dump to less than 5% on the waste tank. 
 

 
 

 
 
Acknowledging the warning moves the program to the next step. 
 

 
 
When that's complete, the program will wait for the quantity to drop to the lower limit. 
 

 
 



SHUTTLE SYSTEMS TRAINING ORIG: M. GRABOIS SYS PGSC 31195 
 DATE: MAY 2009 6.0 CLASS NOTES 
 

 
 
If the dump is required to be terminated early due to low nozzle temps, the background will flash yellow and give 
an audible alarm. The next step is to immediately terminate the dump by closing the dump valve, wait for a 
bakeout of the lines and nozzle, and then try again. 
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4.2.3.8 Step H: Supply H2O Dump Termination 
 
When at least one of the tank quantities is at the lower limit, another tone sounds and the background flashes 
bright green. 
 

 
 
Alternatively, if the dump is required to be terminated early due to low nozzle temps, the background will flash 
yellow and give an audible alarm. The next step is to immediately terminate the dump by closing the dump isol 
valve, and then proceed to step H (dump termination). The crew should check with MCC about performing a 
supply dump through the FES to complete the dump. 
 

 
 
The dump isol valve is closed (using the Control Panel if required) and then the program waits 60 seconds to 
verify that the tank quantities are not decreasing. 
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If the quantities do continue to decrease, a yellow warning box appears with actions 
 

 
 
While water was dumping overboard, the pressure in the lines (31 psi) was greater than the cabin pressure (14.7 
psi) so water did not come into the cabin and cabin air did not go overboard. Now that the dump isol is closed, air 
is flowing through the purge device that was plugged into the contingency cross-tie. This air is meant to purge the 
line so that water does not collect at the dump valve. Prior to using this purge device, water would freeze at the 
dump valve and crack the valve, causing trickle flow overboard. 
 
The dump isol valve is kept closed until the nozzle temperatures exceed 250 degrees for the bakeout of water in 
the lines. For standalone training, this must be done using the Control Panel demo.  
 

 
 
The background flashes bright green when that occurs. 
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After the bakeout of the lines, the dump valve is cycled closed for 60 seconds (while the purge device pressurizes 
the line segment), then open for 60 seconds (while the purge device flows more air), then closed again. This will 
be reflected on the schematic if it is called up. 
 

 
 

 
 
Once the dump isol valve is closed, the nozzle heater is turned off.  
 

 
 
The program steps through each of these switch throws once the valve or switch position has been verified 
through telemetry. After 30 seconds, the temperatures are verified to be not increasing. 
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A yellow warning box appears if the temps are still increasing, with actions for the crew to disable the heaters. 
 

 
 
The crew is reminded to remove the purge device and stow it until the next dump. The "Next" button completes 
the nominal dump procedures. 
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If the dump was terminated early due to low temperatures (suggesting that the water is freezing at the nozzles), a 
note tells the crew to check with MCC for future dump acations. 
 

 

4.2.3.9 Step I: Waste H2O Dump Termination 
When the appropriate point for terminating the dump (based on time or quantity) has occurred, it's time to close 
the waste dump valve. Then the program verifies that the quantity is not decreasing over 60 seconds.  
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If the quantity does decrease, a yellow warning block appears to have the crew cycle the dump valve. 
 

 
 
Meanwhile, the program is also monitoring the nozzle temps. When they exceed 250 degrees, the background 
flashes bright green. The next step is to turn the nozzle heater off. 
 

 
 
Once the dump valve talkback is verified to be barberpole, the program continues to monitor the temps to make 
sure they are not continuing to increase. 
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If the temps do rise, a yellow warning box appears with actions to disable the heaters. 
 

 
 
Finally, when it is determined that the heaters are indeed off, that's the end of the dump procedure! 
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4.2.3.10 Step J: Simo H2O Tk N2 Reg Reconfig 
After both the supply and waste dumps are completed, reconfigure the N2 regs. These valves have no telemetry. 
 

 

4.2.3.11 Step K: Post-Dump FDA Cleanup 
A note says that if comm is available, MCC will reset the FDA limits If not, a window pops up with new limits that 
the crew should set. 
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Finally, the crew is reminded to check with MCC if dual heaters had been used during this supply and/or waste 
dump. 
 

 
 

 


